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Security

1 SECURITY

PBST provides a base set of security roles that can be used by ITCs and districts to grant access to the various folders

available. All roles created by the PBST Team begin with AH-.

View Roles

% School Name
# T Al Buildings
& T | AllBuildings
& T Al Buildings
& T | Al Buildings
# T Al Buildings
& T Al Buildings
& T Al Buildings
& T | AllBuildings
& T AllBuildings
& T Al Buildings
# T Al Buildings
# T | Al Buildings
& T AllBuildings
& T | AllBuildings
& T AllBuildings
& T | AllBuildings
& T Al Buildings

School: |All Schools W| Role Name: ILQH-

Role

AH-Assessment Admin Viewer
AH-Assessment Viewer
AH-Attendance Admin Viewer
AH-Attendance Viewer
AH-Discipline Admin Viewer
AH-Discipline Viewer
AH-Eligibility Admin Viewer
AH-Eligibility Viewer

AH-EMIS Admin Viewer
AH-EMIS Viewer

AH-Fees Admin Viewer
AH-Fees Viewer

AH-Full Admin Report Manager
AH-Full Admin Report Writer
AH-Full Admin Viewer

AH-Full Report Writer

AH-Full Viewer

x | [ search |
& T AllBuildings = AH-ITC Report Manager
# T AllBuildings  AH-Marks Admin Viewer
# T AllBuildings = AH-Marks Viewer
# W AlBuildings  AH-Medical Admin Viewer
& T AllBuildings  AH-Medical Viewer
& T AllBuildings  AH-Scheduler %
# T AllBuildings  AH-Scheduling Admin Viewer
# T AllBuildings  AH-Scheduling Viewer
& T  AllBuildings  AH-School Admin Viewer
& T AllBuildings  AH-School Viewer
# T  AllBuildings  AH-Staff Admin Viewer
& T AllBuildings  AH-Staff Viewer
& T  AllBuildings  AH-Student Admin Viewer
& T AllBuildings  AH-Student Viewer
& T AllBuildings = AH-Vendor Extracts Admin Viewer
& T AllBuildings  AH-Vendor Extracts Viewer
& T AllBuildings  AH-Year End Admin Viewer
& T AllBuildings  AH-Year End Viewer

35 Records Displayed

Back To Top

There are two main types of roles: Viewer and Admin Viewer. A base viewer role grants access to the main Ad Hoc folder

type but not to its admin folder.

Note: “Full” roles should not be used in conjunction with the individual module folder names.

Example 1: John Smith needs to have access to run different report types at different buildings and he should be able to
use any report available no matter the folder level, including admin. This means his role security should have AH-Full

Viewer.
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Security

Example 2: John Smith needs to be able to access different module folders within different buildings and should not be
able to run reports outside of those areas. At the high school, he needs EMIS and admin folders. Also at the high school,
he should have access the Medical folder but no access to the Admin folder. At the middle school, he needs to run
Attendance reports and Attendance Admin reports. At the elementary school, he should have access to run Mark
reports but no access to the Marks Admin reports.

Security - User: John Smith

5

User User Roles Staff Member Impersonations User Groups Group Memberships Reset Password
Is Vendor:
School:| v Role:: -Change Student Number V|

School Role

T Al Buildings EMIS

T Al Buildings Portal Viewing

T Al Buildings RB-EMIS Coordinator

im) High School AH-EMIS Admin Viewer

T High School AH-Medical Viewer

o) Middle School ~AH-Attendance Admin Viewer

Ty Elementary AH-Marks Viewer

Besides the Admin Viewer and Viewer roles, there are two manager roles.

e AH-Full Admin Report Manager — Meant for district support personnel to create and manage reports for
districts. This role can delete and change existing district reports.

e AH-ITC Report Manager — Meant for ITC support personnel to create and manage reports for districts. This role
also has access to the ITC folder, which contains reports that can be run for the entire ITC at once.

Note: There are two Writer roles (AH-Full Report Writer & AH-Full Report Admin Writer) that were
originally created when Ad Hoc Reporting was implemented. They are no longer valid and should
not be used.

If additional roles beyond the PBST base roles are needed, they can be created. There are two security sections that
security administrators need to be aware of when creating new roles:

Security - Role: AH-Assessment Admin Viewer

Administrative School: All Buildings v

Role Name:” |!AH—Assessment Admin Viewer x

Available Assigned

GEORGETOWN EXEMPTED VILLAGE SC St. Jude

Georgetown Elementary = = Summerside Elementary School A

Georgetown Jr/Sr High School & 99 St Jude District v
Clough Pike Elementary School

Edit Sitemap Access Edit Resource Permissions
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1. Edit Sitemap Access -> Local — This section grants users the ability to create and store reports into My
Reports and possibly other places based on their Ad Hoc Reports security section under Edit Resource
Permissions. At minimum, a user should have a blank or green dot on the Analytics Hub in order to run Ad
Hoc Reports. If users should not have access to the Report Designer, you need to have an X on the Ad Hoc
Reports line as shown below.

-4y Display: Add: Change: Delete: - Local
[ Display: Add: Change: Delete: - Report Builder
1) Display: add: Change: Delete: - Report Builder Links
[ Display: X - Ad Hoc Reports
~[ Display: - Analytics Hub

2. Edit Resource Permissions -> Ad Hoc Reports — This section is found under the Edit Resources button of the
security roles. The resources option controls folder access and the available reports within those folders. As
you can see in the screenshot below, the security nodes available mirror the folder structure. Permissions
granted to these nodes will allow a user to gain access to reports within these folders.

Resource Security Nodes Ad Hoc Folder Structure

~ Ad Hoc Reports My Reports
All Data Objects View: v x N > Pending REle'tS
Report Scheduler View: v «x 3 > Assessment

¥ Report Types View : Update: + «x » Attendance
v Assessment View: + x Update: + «x > Discipline
Assessment (Admin) View: v x Update: « x ’ Ellglbllity
> EMIS
» Attendance View: v x Update: v x ) Fees
» Discipline View: v x Update: « x > Marks
» Eligibility View: v x Update: v x > Medical
» EMIS View: v x  Update:[v x > Scheduling
» Fees View: v «x Update : v x > School
P ITC View: ¢ x Update: v x ) Staﬁ
» Marks View: « =x Update: « x > StUdent
» Medical View : Update: + x > VEI'ICIDI' ExtraCt
» Scheduling View: v x Update: + x ) YearEnd
» School View: v x Update: v x
> Staff View: v x Update: v x
> Student View: v x Update: « x
» Vendor Extract View: «v x Update: v x
» YearEnd View: v x Update: v x
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Security
1.1 SECURITY ROLE EXAMPLES

If additional roles need to be created beyond what PBST has provided, this section provides some examples of site map
permissions and how the folder structure will be viewed by the user through the Ad Hoc Reporting module.

1.1.1 Report Manager
Security Role Access

Full access to all data objects, system-level report folders and

scheduling reports
* Ad Hoc Reports

a-
. |-

¥ Report Types

1.1.2  All Reports Read-Only Example
Security Role Access

Display access to all reports

@ Ad Hoc Reports

v x
v x

¥ Report Types

1.1.3 Discipline Admin Read-Only Example

Security Role Access

Display only to Discipline and Admin folders
¥ Ad Hoc Reports

v x

¥ Report Types

View: Update: x

View: Update: + x

x

Folder Access
Full access to all report folders in the report

designer
My Reports

-, » Pending Reports

3 > Assessment
Attendance
Discipline
Eligibility
EMIS
Fees
Marks
Medical
Scheduling
School
Staff
Student
Vendor Extract
YearEnd

Folder Access
The user will not have designer access but will see
all areas within the Analytics Hub area

Folder Access

User can only see Discipline folder and sub folder
on the Analytics Hub screen. They will not have
access to the Report Designer area.

v 4
View: Update : «~
v x

v x

v x v x

~ Discipline D\'%ew: * Update: «+ x=
v x L4 x
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1.1.4 Discipline non-Admin Read-only Example

Security Role Access Folder Access

Display only to Discipline folder and block Admin folder User can only see Discipline folder, Admin is hidden
v Ad Hoc Reports on the Analytics Hub Screen. They will not have

v x
¥ Report Types View: Update: + =
v x

v x access to the Report Designer area.

v x

v x v x

¥ Discipline View: Update: + x

. QR

SECURITY TIPS

Users can be restricted as to where they can run reports by building level; however, it does not mean that they
can only run reports for that building. Users who can run Ad Hoc Reports do so for the entire district even
though they may not be able to access the entire district via the rest of the web application.

All users have their own My Reports folder. My Reports a writable folder where users can copy existing
reports to or create their own reports.

Users with write access to at least one of the “system-level” report folders will get access to a district level
Pending Reports folder. The Pending Reports folder is a special district-level folder used for working on new
reports.

Once a report is ready for release, a district report admin can move the report to the appropriate system-level
folder (e.g. Discipline, Fees, Marks, etc.), thus making it available for other users to run.

|”
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Analytics Hub
2 ANALYTICS HUB

Ad Hoc reporting is available within the ProgressBook Suite as an effective standardized reporting system for
Studentinformation and related applications. The Analytics Hub provides a simple way for users to run reports. It can be
accessed two ways within Studentinformation. Users can follow the breadcrumb trail Local -> Analytics Hub — OR — click
the Page Widget found on the top right side of the Studentinformation tool bar.

SIS

Studentinformation
Teacher Menu

. EZ Query
Headlines

Management

v HCCA3 EMIS

Software Releas (e ki

HCC Staff have instalJRaIIAS

If all goes well, and nq
I Ad Hoc Reports

I Analytics Hub

Once a date has bee

Palaaca natac far var

High School =

[ Analytics Hub

Daily Attendance Detall
T 5 Credit Rule Check

The page widget also shows users the most recent reports that they have run. On the Analytics Hub screen, a list of
reports display depending on the security roles assigned to the user.

Analytics Hub

> Mdr_"keports
wAssessment

ACT Export

Used to create the Pre-ID file to upload for the ACT State Test day for 11th grade students.

Preschool ELA Pre-ID Enrollment File

This report creates the Enroliment file as part of the Preschool ELA Pre-ID process.

Preschool ELA Pre-ID Teacher File

Provides a file of Preschool Teachers needed to complete the PS ELA PRe-ID process. Run in
conjunction with the Student File report and the Enroliment File Report

wAttendance

Daily Attendance Detail

Provides Excel/CSV compatible list of student attendance filtered by date or date range.

i}
fii

JVS ACT Export

Used to create the Pre-ID file to upload for the ACT State Test day for 11th grade JVS
students. Reporting High School School Code fields is filled out with HomeSchool IRN field. To
be run by JVS Schools.

Preschool ELA Pre-ID Export

This report produces the Pre-ID student file for students taking the Preschool ELA
Assessment. File should be saved as a CSV file

SAT Pre-ID File

Used to create the Pre-ID file to upload for the SAT State Test day for 11th grade students.
This report contains any 11th grade student with FTE > 0

Daily Period Attendance

Provides Daily Period attendance

Once you select a report, the screen will refresh and either show filter options for the user to choose the data they
would like to review within the report or the report will execute.
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%Analytics Hub

SAT Pre-ID File

Filter By
StudentEmisFS.SchoolYear
StudentContact.SchoolName
StudentEmisFS.GradeLevel

StudentContact.StatusName

Equal To
Equal To
Equal To

Is One Of

Analytics Hub
B2 =

Filters X

Condition Value

~ 2016-2017

€ ¢ ¢« ¢

~ 11

~ ~

0K ¥ Cancel

After a report displays data, you can review the report by flipping through the data pages or using the find box to locate
specific data within the report. Users will also be able to download the report with the available export icon.

SAT P{"DID File

LEO)

&< »%» 1 /29 Find. AV

To get back to the main Analytics Hub to see the cards or list of reports, click the icons found at the top right of the
Analytics Hub screen. The left icon displays the reports and their descriptions in the card format. The right icon provides

a simplified list of reports and descriptions.

;Analytics Hub

SAT Pre-ID File

®Bn

« < »» 1 /29 Find AV

Note: Analytics Hub Only users can only run reports.
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Report Designer Overview

3 REPORT DESIGNER OVERVIEW

To access the Ad Hoc Reports Designer screen, users must go to the breadcrumb trail Local -> Ad Hoc Reports. If a user
does not see the Ad Hoc Reports option, it means the user does not have the right security configuration.

@*udenﬂnfurmaﬁun = Local

Local

Please make a menu selection

Ad Hoc Reports Report Builder Links
Analytics Hub

3.1 REPORT DESIGNER LAYOUT

% Oe Ad Hoc Reports @
zoucu @

Search report names o
My Rli}pns

» Pending Reports
» Assessment

» Anendance

» Discipline

» Eligibility

» EMIS

? Fees e
» Marks

» Medical

» Scheduling

» School

> Staff

» Swdent

» Vendor Extract
» YearEnd

Report Description

1. Report Creation Wizards — Click this icon to bring down an icon drop-down list and allow users to start one
of 4 report wizard options: ExpressView, Express Report, Standard Report, and Crosstab Report.

ProgressBook Studentinformation Ad-Hoc Reporting 8



Report Designer Overview

%
+ O
Discover
ExpressView
Build
Express Report
Standard Report

Crosstab Report
a. ExpressView ( ) — Explore data and get quick answers using drag & drop in a highly interactive
designer.

b. Express Reports ( ) — Quickly create tabular reports with essential operations like sorting,
filtering, and calculations. Easily format and summarize data.

c. Standard Reports ( ) — A familiar, Excel-like design grid with access to advanced functionality like
Charts, Maps, the Formula Editor, and Conditional Formatting.

d. Crosstab Reports () — An intuitive Crosstab Wizard simplifies the process of creating complex
tables with summary results grouped in both rows and columns.

Run Reports (O) — Select a report and then click on an extract type icon lets the user execute a report. See
Section 3.5 for further details regarding this feature.

Report Management Toolbar — The user will need to go to the module folder window (see step 5) and locate
the report to which they would like to perform one of the following tasks:

xOGE G
Q0006

Edit Report — Select a report and then select this icon to edit a report that is not locked.

b. Duplicate Report — Select a report and then click this icon to create a copy of a report for further
customization. See Section 5 for more details regarding this feature.

c. Delete Report —Select a report and then click this icon to delete a non-system report.

d. Schedule Report — Select a report and then click this icon to schedule a report; you can immediately
send the report to one user or the manage reports scheduler queue.

e. Export Report — Select an option to run and automatically export a selected report into Excel, PDF,
RTF, or CSV.

Search Reports ( ) — Use the search bar to find any available report within the
system to either run or edit it. Click the sprocket settings at the end of the search toolbar to search by name
and/or description depending on how fast/slow you want the search to produce results.
Module Folder list — This section contains a folder list related to the available modules as well as reports
available to the user based on their security access. See Section 3.3 for further details.

a. Report Description — Selecting a report will display a report description in this section.
Report Tabs — As you run or edit reports, a tab will appear for each instance.

ProgressBook Studentinformation Introduction to Ad-Hoc Reporting



Report Designer Overview

3.2 REPORT TYPES
1. System Report — A report created by the PBST group and dispersed to the ITC/Districts via Syncer.
a. System Reports can only be created and distributed by the PBST. It is a read only report and will have a

lock icon.
b. System Reports are synced to corresponding folders [Discipline, Fees, Attendance...] from the State Level

to the ITC.
2. District Report — A report created by personnel with the ITC/District. District Reports are created when:

a. A System Report is copied — that copy is considered a District Report.
b. District reports are not read only, which means anyone who can modify reports can do so at any time

within the district.
c. A user can create a District Report using the SIS data categories provided.
3. User Report — A report that exists in a user’s My Reports folder.

3.3 MODULE FOLDER STRUCTURE

When viewing the module folder structure in the Ad Hoc Report Designer, any or all folders may display to a user
depending on the security provided. Security Roles have been designed to mimic this structure. Within each main
modaule topic folder, there is an Admin folder than may contain reports needing more restrictive access.

My Reports

Pending Reports

Assessment

Attendance

Discipline
Discipline Actions for Special Educati
Discipline by Ethnicity Count
Discipline Detail
Students Without Discipline Report

Admin

My Reportso

% Pending Reports
Assessment
Attendance

Nicrinlina

3.4 REePORT FOLDER TYPES

1. My Reports folder — A holding area for User Reports.

a. Every user with access to the Report Designer has a My Reports folder.

b. Users may duplicate any report they have access to and store it in their My Reports.

c. Users may modify/delete any report in their My Reports folder.

d. Only the logged in user has access to this folder. ITCs cannot assist users with reports within this folder
unless the report is moved to the Pending Reports folder or downloaded and sent to ITC support. DBAs
can grab the stored xml code from the database but it is not a preferred method of
viewing/troubleshooting Ad Hoc Reports.

ProgressBook Studentinformation Ad-Hoc Reporting 10



Report Designer Overview
2. Pending Reports — A holding area for users who can create reports and distribute them to other module folders.
Typically, users who have access to this folder will be district power users or ITC Support.

a. Users that have “Edit” capabilities will have access to the Pending Reports folder.

b. Users with access may also delete District Reports from this folder.
3. Module Report Folder

a. Contains System Reports and district created reports to all users with access.

b. System (Locked) Reports in the application folder cannot be deleted or moved.

c. System Reports in the application folder can only be copied and may be stored in any folder the user has

access.

3.5 REPORT EXECUTION
There are many ways you can execute reports within the Ad Hoc Report Designer screen.

1. Expand the Report Folder type > Select the Report > Click on the Run button or Export button and selecting an

export option.
I O e

LE]LJETD’/

X xs

M por

Search report names.
v My Reports
Discipline by Eth) —=
» Pending Reports =
> Assessment

» Attendance X: csv
~ Diseinline

2. Expand the Report Folder type > Right click the Report name you want to run, then select the Run button or
Export button and select an export option.
~ My Reports
Discipline by Ethnicity Count
> Pending Reports

> Assessment
> A%ance
~ Discipline /

I Discipline Actions for Special Educatic
Discipline by Ethnicity Count @ Run Report
Discipline Detail Export As N
Students Without Discipline Report x XLS
Admin (@ Sschedule Report
> Eligibility . A PDF
5 EMIS 4 Email Report >
> Fees . -=
Duplicate == RTF
> Marks U P -
» Medical

> Scheduling X: csy
» School

11 ProgressBook Studentinformation Introduction to Ad-Hoc Reporting



Report Designer Overview
3. While editing a report, you can execute it from the designer toolbar using either the Run button or Export

button.
Discipline by LE\Emicity Count Ad Hoc Reports
DisciplineOffender - o B[+ @7 Al -

O

AdjudicationType o BIuUuA®f

AltEducationind

Section A B D E
ArrestType
DateModified Page Header 1 Discipline by Ethnicity Count

Disciplinelncidentld Detail 2 DistibineO fEndsE SEhooiNa

3.6 EXPORT OPTIONS
After a report has been executed, you can either review the report within the Studentinformation application or export
the report data into one of several available format types. These format export types currently include:

1. Excel( X wus ) — Will export your report and open it using Microsoft Excel. You will also have the option to
save it to your hard drive as a xlsx file.

2. PDF({( A poF ) — Will export your report and open it using Adobe Acrobat Reader. You will also have the
option to save it to your hard drive as a pdf file.

3. RTF(*- ar ) — Will export your report and utilize any program that is compatible with RTF files. You will also
have the option to save it to your hard drive as a rtf file.

4. CSV( Xz csv ) — Will export your report and utilize any program that is compatible with csv files. You will also
have the option to save it to your hard drive as a csv file.

ProgressBook Studentinformation Ad-Hoc Reporting 12



Report Filtering
4 REPORT FILTERING

If there are no filters to be completed, an Ad Hoc Report will execute automatically and display the data results. There
will be some created reports that will greatly benefit from having a few pre-determined filtering fields. Some examples
are school year, building, grade level, or a combination of several fields.

When an Ad Hoc System, District, or User report requires parameters, one of the following parameter type windows will
display to the user.

4.1 SiMPLE WITHOUT OPERATOR

This filtering type is the easiest to use. The user will simply select values from available filter dropdowns. They will click
OK and the report will generate.

Filters x

Fitter By Condition Value
Student&ddressStandardizationErrors.City  Equal To | R
CLOVERDALE ~
COLUMBUS GROVE
CONTINENTAL
ELIDA
FORT JENNINGS
FT JENNINGS
FT. JENNINGS
GILBOA
GLANDORF
GOMER w

v OK ¥ cancel

4.2 SIMPLE WITH OPERATOR

This filtering type allows users to select a condition type as well as values from available filter dropdowns. Once a
condition and value(s) have been selected, the user will click OK and the report will generate. The condition statements
that are available are: Equal To, Not Equal To, Less Than, Less Than or Equal To, Greater Than, Greater Than or Equal
To, Starts With, Not Starts With, Ends With, Does Not End With, Contains, Does Not Contain, Is Between, Is Not
Between, Is One Of, and Is Not One Of.

e The ls One of and Is Not One Of conditional statements will allow users to choose multiple values.
e Is Between is useful if users want to select a Date Range between 2 dates.
e Not Equal To or Is Not One Of is useful if you do not want to select any values at all for certain filters.
o Example: If users want all GradeLevels or all Status options returned for students, they will select the
Not Equal to or Is Not One Of condition statement and leave the field blank. This type of filtering works
because all students must have a grade level and status assigned during registration. Therefore, all
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Report Filtering
students will be returned because no students within the database will have a blank value for either
field.

Filters X

Fitter By Condition Valug
StudentAddressStandardizationErrors.City  Egqual To W b
Not Egual To
Less Than
Less Than Or Equal To
Greater Than
Greater Than Or Equal To
Starts With
Mot Starts With
Ends With
Does Mot End With
Contains
Does Mot Contain
ls Between
Is Not Between
Iz One Of
Iz Not One OF

v OK # Cancel

4.3 STANDARD/DEFAULT FILTERING

This filtering option is the hardest to understand and can be a little daunting. However, standard filtering can make a
simple standard report very powerful and versatile. Users can set up default filtering values during the report
design/editing process along with default values. When running a report, the filtering screen works the same way as
when you create/edit a report.

Report Filters X
Select filter fields to include on report [% o Switch to GROUP (MIN/MAX) Filters
Filter By
o ' £ StudentDemographicCore.SchoolYear AV X
_DistBldg £ StudentDemographicCore.SchoolName AV X
_Year A £ StudentDemographicCore.StatusName AV X
AttendanceCode £ StudentDemographicCore.GradeLevel AV X

Birthdate e

BirthdateVerification e

BirthplaceCity

BuildingProgressionTrack

CalendarBuilding

CalendarCode

CalendarName

CalledName

CitizenshipCode

CitizenshipName

Counselor e Equal To ~| 12017-2018 ve

DistrictCode AND With Next Filter -
Districtld

NictrintIDN [ &roup with Next Filtee
= Add M Prompt For Value
SUMMARY

StudentDemographicCore.SchoolYear = '2017-2018" And StudentDemographicCore.SchoolName Is One Of () And StudentDemographicCore.StatusName Is One Of () And StudentDemographicCore.GradeLevel
Is One Of () @

oK ¥ cancel

1. Category Dropdown — This dropdown provides a list of all available categories within the report. You can choose
any field from any category for filtering.
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Report Filtering
Category Data Fields — After selecting a category from the drop-down list, all data fields within the category will
be listed. If users desire, they can remove data fields from section 3 and add different data fields to section 3.
They can also add additional data fields to the already existing ones if the user requires a smaller set of data for
their report.
Data Field Filter List — This section lists all filters that are used for the report. Clicking X removes a filter. Use the
up and down arrows to move filters into a different order.
Switch to Group Min/Max filters — Switching to this option allows you to add additional filters based on
maximum or minimum values of data fields. An example of its benefit is to find the maximum or minimum test
score for each student for an assessment test.
Conditional Filter — This functions the same as the Simple with Operator conditional filter. See section 4.2 for
further details regarding the conditional statements.
Filter Relationship Dropdown — Specify the relationship between filters and group them together if certain fields
are dependent upon one another. Select AND to require that the selected filter and the one below are both
true. Select OR to require that either the selected filter or the one below it are true.
Value Dropdown — This dropdown is populated by data in the database like the other two filtering options
described in sections 4.1 and 4.2. If the drop-down list is blank, this means that there are no values within the
database to further filter on. A blank drop-down list could mean that all the filtering above that drop-down list
has eliminated any available data options that exist — OR — that the data simply doesn’t exist yet in the database.
Group with Next Filter — This is used in conjunction with item 6 with the And/Or option. Enabling this check box
places parentheses around the selected filter and the one that follows to group the two or more filters together.
Prompt for Value — Allow the selected filter to be modified when the report is run.

10. Summary box — This summarizes all of the above filtering options into one space.

Once all parameters have been completed, the user will click OK and the report will execute.

FILTERING TIP

In any of the filtering types, users will have the ability to type into available filtering fields. However, users should be
cautious when typing values in lieu of choosing from the drop-down list. Mistyped values or formatting errors could
produce reports that have little or no results.

15
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5 DUPLICATING A REPORT

Even as a basic Ad Hoc Reporting user, Ad Hoc Reports can be duplicated and stored in the user’s My Reports folder.
After a duplicate has been created, the user will be able to save, edit, and run the report until they delete it. To duplicate
a report, a user will need to navigate to the Ad Hoc Report Designer (Local > Ad Hoc Reporting). After the designer has
been loaded, the user can complete the following steps. In this example, we will be copying the Student Address
Standardization Error Report.

1. Expand the folder where the report is stored from the folder structure on the left. Click on the report to select it.

My Reports

Discipline by Ethnicity Count
Pending Reports
Assessment

ACT Export

JVS ACT Export

Preschool ELA Pr%) Export
2. Either select the double page icon at the top — OR — right click the report to get the pop-up menu and choose

Duplicate.
Assessment
ACT Export
[ JVS ACT Export
N
3 Preschool ELA =*| Export As >
I__I D LI D LI Admin (@ Schedule Report

Preschool ELA
Preschool ELA 7 Email Report  »
Attendance

Discipline [0 Dupiicate

3. A new window will appear for the user to rename (if desired) and place the duplicated report into a different
folder (e.g., My Reports or Pending Reports).

kmer the report name

[SAT Pre-ID File Duplicate] x

Duplicate Report X

Select folder for the report

Discipline by Ethnicity Count
Pending Reports
Assessment
Attendance
Discipline
Eligibility
EMIS
Fees
Marks
Medical
Scheduling
School
Staff
Student
Vendor Extract
YearEnd

OK K Cancel
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Duplicating a Report
4. Click OK to finish the report duplication process. The user is then redirected back to the main Report Designer
screen and will be able to expand the folder structure to see the new report. Now, the user can execute or edit it
as desired.

Note: When duplicating and modifying a report, the child copy is not linked to the parent original. If
a change occurs to the parent original report, that change will not sync down to the child copy.
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6 REPORT SCHEDULER

6.1 SCHEDULING REPORTS

Any existing report within the Ad Hoc Reporting system can be scheduled to run and either emailed or FTP’d to users. To
schedule reports, you must complete all scheduling from the Ad Hoc Report Designer screen (Studentinformation >
Local > Ad Hoc Reports).

1. You can schedule a report via the Ad Hoc toolbar or by right selecting a report and choosing Schedule Report —
or —select a report and click the page with the clock from the toolbar above.

ODEG

N

I My Reports
Pending Reports [ Edit
Assessment
Attendance () Run Report
Discipline
=»| Export As >
Eligibility P
EMIS (D' Schedule Report
Fees )
Marks &5 Email Report >

2. Once you click Schedule Report, the Report Scheduler wizard displays.

% Schedule Report Ad Hoc Reports
Complete the steps in the wizard below to schedule a report

Recurrence L\ ilte R
3

Schedule Name|

e Export Type PDF ~  Password (optional) Confirm Password e
[] Execute Imm:d\atcwo

Schedule Time

Schedule Time D [ Repeat Every

Recurrence Pattern G
® once

O Daily

O Weekly  Schedule On
O Monthly

O vearly

Range of Recurrence e
@

o]

A. Schedule Name — Enter the name of the job.

a. For example, you want to run the Contact Address Standardization Error report every night after the
service job runs, so that you know which addresses need to be corrected the next day. An example
schedule name would be “Contact Address Standardization Errors @ 9 PM Nightly.”

B. Export Type — Select Excel, PDF, CSV, or RTF from the drop-down list.

ProgressBook Studentinformation Ad-Hoc Reporting 18
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C. Password (optional) — The password fields can be set so the file can only be opened with a password. You

must remember to tell your recipients the password so that they can open the file. If you forget the
password, you will have to edit your job, change the password, and rerun the scheduled job.

D. Execute Immediately — You can select this check box to execute the report immediately but all other
scheduling options will become unavailable.

E. Schedule Time — Select or enter the time you would like the report to run. When you click @', a drop-down
list displays and you can select an hour or half hour time period. If you want to run the report at a different
time, you can type in a time or select an option and then edit it.

F. Recurrence Pattern — The default option for the recurrence pattern is Once. Other options for recurring
patterns include: Daily, Weekly, Monthly, and Yearly. Each recurring pattern option has different settings to
ensure that the report can be sent as it is needed.

G. Range of Recurrence — Once a recurrence pattern is set, the range of recurrence will become available so
that you can choose the time period in which the report will run.

3. After you select all scheduling options and click Next, you are taken to the Filters tab. If any filters are required
for the report to run, you will set up the report so that it provides the detail that is needed. See section 4.3 on
how to utilize the Standard Filtering screen.

% Schedule Report Ad Hoc Reports

Complete the steps in the wizard below to schedule a report
Filters F ient

Select filter 'u\\.'[:'g include on report

Filter B;
DisciplineOffender ~ = z
| StudentDemographicCore. SchoolYear
AdjudicationType £ StudentDemographicCore.SchoalName
AltEducationind
ArrestType
DateModified
Disciplinelncidentld

A 2 StudentDemographicCore. StatusName

>35>
< <K

< StudentDemographicCore. GradeLevel

DisciplineOffenderld

inePersonld

InjurySustainedind
LLEContactedName

LLENotifiedind
ModifyingUser
N tterind
OffenderAge

OffenderComment
OffenderType
Schoolld
SchoolName
SchoolYear
SchoolYearld
Studentld
StudentName
Userld - AND With Nex
WeaponDetectedComment [ Group v

o= Add
SUMMARY

Equal To ~ ~

1 Filter ~

Nith Next Filter

StudentDemographicCore. SchoolYear = 2017-2018 And StudentDemographicCore SchoolName Is One Of ) And StudentDemographicCore StatusName Is One Of () And StudentDemographicCore GradeLevel Is One Of ()

X Cancel < Previous  Next > [ Finish

Remember: If no filters are chosen, incorrect or no data will be provided in the report.

4. Once allfilters are selected, click Next and the wizard will move you to the final Recipients tab. Here you will be
able to setup to whom the report is sent on a regular schedule.
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% Schedule Report Ad Hoc Reports

Complete the steps in the wizard below to schedule a report

Recurrence Filte Recipients

Subject Scheduled Ad Hoc Report

X Cancel < Previous

Email Results

f# Finish

While you are provided a subject line by default, it is recommended to change the subject line to something meaningful
to you and/or the users receiving the scheduled report. Once everything is completed, you can click Finish. A display

windows states that the report is successfully scheduled.

X

Report has been scheduled

ProgressBook Studentinformation Ad-Hoc Reporting
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6.2 SCHEDULED REPORT MANAGEMENT

To manage your scheduled reports, you must use the Ad Hoc Reporting toolbar available within the Ad Hoc Report
Designer screen (Studentinformation > Local > Ad Hoc Reports).

OCGEDO

Schedule Report{b
Email Report V
Manage Scheduled Reports

From the Scheduled Reports screen, you will be able to see all of the information pertaining to your scheduled reports,
edit the scheduled report job parameters, and delete the scheduled report job.

My Reports

(=2 A v RS

Pending Repor..
Assessment

.
“§ scheduled Reports Ad Hoc Reports

Schedule Name Type Report Name Last Execute Date Next Execute Date Status Run Count
teast Daily Discipline by Ethnicity Count 10/12/201701:00:00  Ready 0 x

© e G 000

Schedule Name

Type of Scheduled Job — Type of recurrence pattern scheduled
Report Name — Name of the report that the job is running

Last Run Date — Shows the date the report was last run successfully
Next Run Date — Shows the next date the report is scheduled to run
Status — Current job status

Run Count — Number of times the report has been run or attempted
Icon to edit the scheduled report job parameters

Icon to delete the scheduled report job

S®m 0 o0 T

6.3 EMAIL REPORT

The second option from the Ad Hoc Report toolbar, Email Report, lets you select any report available to you and email it
to one person.

My Reports |j (™ Refresh 17 Flush
L OG G Schedule Name
Pending Reports [/ Edit '_j Schedule Report
Assessment
Run Report
Attendance C) P R '_J’ Email Report ’ “ﬂelissa.bauer@mcoecn.org x|L|
P y Reports
| > =
E;Is;:::::;'ye Export As Pending Repor '_j Manage Scheduled Reports
Assessment
J¥ Schedule Report
EMIS O P Attendance
Fees i Discipline
Y Email Report ’ - .
Marks |h16||ssa.bauer@mcoecn.org X | L| Discipline Actions for Special Educatic
Medical D Rename

Discinline Detail

Note: If multiple recipients need to receive a copy, you must to schedule the report.
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6.4 SCHEDUUING FTPJoB

6.4.1 Report Setup
Reports within the system can be FTP’d but before that can happen, the report must be marked as Is_Vendor_extract.

1. To ensure that this setting is complete, right click and edit a report. Click on the settings sprocket -> Options ->

Custom.
B[+ 3 & anal -

% -~ =L m 7 U A%®B =
Rename
= A

Description
Discipline by Ethnicity Cc

&1 Sorts
"W Filters
Schnnl
Options  * {3} General
! |
& Template (& Report Viewer wooll

Advanced » D Custom

Report Footer 6 ="Page" & @pageMNumberd

2. A new window will open for designers to enable the Is_Vendor_Extract check box. Click OK, then Save. The
report will now show up on the Vendor Extract Report Config district administration screen.

Note: Any reports found within the Vendor Extract folder and is distributed by PBST will have the
Is_Vendor_Extract check box selected.

6.4.2  FTP Server Setup
Before you can transfer files created by Ad Hoc Reports through FTP or SFTP, you must set up the credentials for

accessing the server on the Vendor Extract Report Config screen. The server should already be set up for (S)FTP and you
should have the credentials on hand.
1. With a district in context on the Vendor Extract Report Config screen, browse to Studentinformation —
Management — District Administration — Vendor Extract Report Config and click Add Configuration.
2. The Add Configuration window displays.
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Add Configuration ®

Ad Hoc Report ‘ My Reports\VendorExtract2-fip v
Host ‘ localhost
Port ‘ 21
Protocol ‘ FTP - File Transfer Protocol v
Encryption | None v
Username | test
Password | -
Remote ‘
Directory
Remote ‘
Filename

Test Connection Save Configuration

& Connection established!

3. Enter the appropriate credentials in the fields.

e Ad Hoc Report — Select an Ad Hoc Report that has the Is_Vendor_Extract check box selected.
Note: Only Ad Hoc Reports with the Is_Vendor_Extract check box selected display in this list. If there are no
reports with Is_Vendor_Extract selected, nothing displays.

e Host — Enter the name of the host.

e Port — Enter the port number.

e Protocol —Select SFTP or FTP.

e Encryption (only displays if you select FTP) — Select the type of encryption to use.

e Username — Enter the username for the FTP server.

e Password — Enter the password for the FTP server.

e Remote Directory — Enter the remote directory to which the transfer file is sent.

e Remote Filename — Enter the remote file name that displays after the transfer complete.

4. Click Test Connection to verify that the credentials are accurate. If you receive an error message, ensure the
credentials you have are correct and entered correctly.

5. Click Save Configuration.

6. A confirmation message displays and the new configuration is added to the grid.

) Q ) (
Vendor Extract Report Config © Add Configuration \

Success! The configuration was Successfully Saved

Ad Hoc Report Host Port Protocol Type Username Remote Directory Remote Filename

& W crnt1.software-answers.com 21 Sftp test reports test2
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7. You can now run the corresponding Ad Hoc Reports, which automatically transfer via (S)FTP.

6.4.3 Schedule the FTP Job

Once the report has been enabled to be a vendor extract and the system knows where to send the files, a scheduled
job must be set up to tell the system how often to run the report and what filters should be used. To do this, you must
go back to the designer screen and run the schedule job wizard. Section 6.1 explains how to set up the job. The only
difference between emailing and FTP’ing is the setting on the Recipients tab — de-select the Email Results check box in
the top right corner. De-selecting this check box forces the job to run as an FTP job and utilizes the settings from the
Vendor Extract Report Config screen.

% Schedule Report Ad Hoc Reports
Complete the steps in the wizard below to schedule a report
Recipients
T [0 Email Results
To:
Ce:
Bec
Subject: Scheduled Ad Hoc Report
X Cancel < Previous Finish
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7 SHARING REPORTS

Only users who have access to the Report Designer may share reports. Report Design users can share reports by
downloading a WR file from the Report Designer screen. Only files that are unlocked can be downloaded. Locked reports
must first be duplicated before downloading. After the file has been downloaded to their local machines, users can
share the WR file with another district, their ITC Support team, or with the PBST group via email or a file sharing
program. Any design user can also upload a WR file to any module folders that do not have a lock.

7.1 DOWNLOADING A REPORT
1. On the Ad Hoc Reports screen, locate the report that you want to download and share (without a lock).

My Reports Disciplineln
D Niscinline1

Pending Reports [/ Edit

Assessment

Attendance (®) Run Report

Discipline -| Export As N

Discipline Actions for Specie

Discipline by Ethnicity Count (2 Schedule Report
Discipline Detail

Students Without Discipline

&y Email Report ’

Admin L Rename
Eligibility _
EMIS [] Duplicate
e [* Delete
Marks
Medical + Download

Note: You cannot share locked reports. Locked reports are System Reports that are synced down
from PBST.

2. Once your browser gives you the Save option, save the file to your local machine. Typically, most browsers
default the save location to your PC’s Downloads folder, but you can choose to save WR files anywhere,
including your PC desktop.

7.2 UPLOADING A REPORT

1. To upload a report to your local ad-hoc reporting area, right click on a folder that does not have a lock and click
Upload.

% Disciplin ‘= Expand All
Pending Re
Assessmen
Attendance 4 Upload
Discipline

= Collapse All
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2. Your browser then asks you where the WR file you want to upload is located. Navigate to that location, select

the WR file and click Open.
b

® ~ 4 [ » ThisPC » Downloads

Organize « Mew folder

~
4.7 Favorites Name

B Desktop &) testawr
. Release Prep

4 Downloads

=l Recent places

E} SharePoint

#& OneDrive - Management Coun

4 |8 This PC
5o C on MBAUER
i Desktop
| Documents
4 Downloads
o Music

=| Pictures

= Vidanc <

File name: |test.wr

File Upload

Date maodified Type

10/26/2016 1:56 PM  WR File

v

(v]

Search Downloads 2
=~ I @
Size
8 KB
*wr v

Cance'

3. Ad hocimports the file and refreshes the Report Designer screen, which auto-collapses the folders. Expand the
folder in which you chose to upload the WR file and verify that the report WR file imported.
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8 EXPRESSVIEW

8.1 EXPRESSVIEW REPORT

ExpressView allows users to explore data within a category and get quick answers using drag and drop in a highly
interactive designer. To create an ExpressView, complete the following steps.

1. Click the + sign on the top right that provides a list of available reports and then click ExpressView.
Discover

ExpressView

2. A new tab will appear on the main screen of the Report Designer frame. Start selecting data fields from a
category for analyzation.

New Erpressview % Scheduled Reports Ad Hoc Reports

o A = izl v

3. Use the left column of the design window to search for fields across categories. The icons:
A. A —Show only text fields.
B. # - Shows only numeric fields.
C. ¥ —Shows only date/time fields.
D. ** —Shows other fields.

# 13 o8

Assessment
Attendance
Discipline
Eligibility
EMIS

Fees

ITC

4. Once some fields are chosen, more options appear:
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New ExpressView ¥ Scheduled Reports Ad Hoc Reports
; . B ©e a Az Y
A #* w 0 e o @ e GE SchoolName ~1 E GradeLevel ~2 E Gender a3 0 0 o
' e SchoolName 1 Gradelevel 1 Gender 1
E::;j ~ SchoolName 2 Gradelevel 2 Gender 2
Flags SchoolName 3 Gradelevel 3 Gender 3
Flags SchoolName 4 Gradelevel 4 Gender 4
SchoolName 5 Gradelevel 5 Gender 5
GradeLevel SchoolName 6 GradeLevel 6 Gender 6
E:mddw‘:'”d SchoolName 7 GradeLevel 7 Gender 7
ZEZZE::?‘E:;GMN SchoolName 8 GradelLevel 8 Gender 8
HomeLanguage SchoolName 9 Gradelevel 9 Gender 9
Homercom SchoolName 10 GradelLevel 10 Gender 10
HomerocomTeacher
HomeroomTeacherCode
HomeSchoollRN Report Totals

HomaSchoaiame @ Count: Count for School..  Count: Count for GradeL... Count: Count for Gender

IncludelnHonorRoll

InrlidsinRanking

A. Options — This provides a way to save the ExpressView for use later or convert your ExpressView
into a Standard Report to continue to work on later.

B. Save — Saves the ExpressView.

C. Group Expand/Collapse Options — This menu will become available when the report contains one
or more groups.
Refresh Data — Only available when the ExpressView is in Live Mode.
Live Mode — Allows you to view the actual data within the data fields.

F. Data Field Options — Blue Circle that can be accessed to group, filter, sort, and/or delete.

<= N
-f 4 ) A ~ A
I\ x Y TIName 1 E GradeLevel 2 E Gender 3
\ A me 1 Gradelevel 1 Gender 1
A%:,.a ame 2 GradeLevel 2 Gender 2
SchoolName 3 Gradelevel 3 Gender 3

G. Report Tools — Provides summarized data options of fields selected. Options include Count, Min,
Max, and Distinct Count.

%eport Totals
Count: Count for School..~ Count: Count for GradeL... Count: Count for Gender
Min Min for SchoolNa...
Max Max for SchoolNa...
Count Count for Schoo...
Distinct Count Distinct...

H. Search — Search the report for data
I.  Sort—This is the same sort you would utilize in item F.
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Qa AZ'Y
: GradeLev%
- | Gender
- | SchoolName
Apply OK

J.  Filter —You can put data fields into data field values that meet all or any criteria.
% Qa AZ'Y
expand all

Meet all of the following conditions:

and meet any of the following conditions:

Apply OK

Note: If you wanted to filter on a different data field than what you’ve selected to review, users can
drag from the data field column on the far left and drag over to the expanded filtering option. This
option does not work for sorting. If you want to sort on specific fields, you must add them to the
main column set.

5. Once you are satisfied with the ExpressView setup, flip the switch to Turn Live Mode On and start reviewing
data!
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9 EXPRESS REPORT WIZARD

Express reports are for users to create quick on the fly reports that utilize only one category and need little formatting. If
more than one category is needed to create a report, you must use a Standard or Crosstab report feature. This is due to
the joining that must occur between categories to ensure that the data from both categories matches up.

9.1 CREATING AN EXPRESS REPORT
1. Start the Express Report Wizard by clicking Express Report from the Report Wizard Icon menu.

+'0

ExpressView

Build
Express Report
Standard Report

Crosstab Report

R L T TIC TR

2. Onthe Name Tab:
a. Enter the name of the report.
b. Select the folder where the report will reside.

New Express Report Ad Hoc Reports

=
© a

Name Categories Sorts Filters Layout Options B

Select folder for the reporl/
> My Reports
> Pending Reports
> Assessment
> Attendance
> Discipline %
> Eligibility
> EMIS
> Fees
» Marks
> Medical
> Scheduling
> School
> Staff
> Student
» Vendor Extract
> YearEnd

Enter the report name

X Cancel Previous Next > [/ saveand Close

Note: Most reports that users will create will go into the My Reports folder.
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3. Once all fields are completed on the Name tab, click Next to move to the Categories tab.
4. Select one of the views that need to be included into the report and click +Add to add the category to the
Category Name section to the right. Click Next to move to the Sorts tab.
New Express Report Ad Hoc Reports
Name d\}:') Categories Sorts Filters Layout Options B D ®

Select categories to include on report

Suppress
Duplicates

P O StudentDemographicCore X
» Medical A
» Scheduling
» School
» Staff
+ Student
FamilyGroups
PersonAddressStandardizationError.
StudentAddressStandardizationErrol
StudentCalendarLatest
StudentContact
StudentContact_Addresses_Address
StudentLockers
StudentMiscData
StudentNotes
StudentPersonContact
Transportation
Student Count Report District Detail
Student Count Report Student Detail
< >

o= Add (i )

X Cancel ¢ Previous Next > || Save and Close

Category Name

5. On the Sorts tab, select fields and then click +Add to move those fields to the right to add sorting functionality
to the report. Once all sorting fields have been chosen, click Next to move to the Filters tab.

New Express Report Ad Hoc Reports
- ®

-
Name Categories Sorts Filters Layout Options m LJ

Select sort fields

Sort By Sort Order

StudentDemographicCore ~ % StudentDemographicCore.Homeroom Jx Ascending

DistrictName < StudentDemographicCore.GradeLevel f« Ascending
EMISId ~ £ StudentDemographicCore.LastName f« Ascending

FirstName < StudentDemographicCore.FirstName f- Ascending

FiscalYear

Flag1

Flag2

Flag3

Flag4

Flag5

Flags

Gender

GradeLevel
GradeLevelld
GradeLevelSortOrder
GraduationYear
Homelanguage
Homeroom
HomeroomTeacher
HomeroomTeacherCode v
HomeSchoollRN

== Add == Add Formula

C e e
>2 2

<<
X X XX

X Cancel < Previous Next > || Save and Close

Note: Users can use the up and down arrows to customize sorting further if necessary. If the user
decides they do not want to use a sorting option they moved to the right, click the red x to delete
the sorting field.
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6. On the Filters tab, users have the option of adding fields to filter on when the report executes. If a user would like to
add fields, they can select the field and then click +Add to move it to the right and then select conditions on how the
values should be searched upon. See section 4.3 for Standard filtering explanation.

Na{lj Express Report Ad Hoc Reports

d
Name Categories Sorts Filters Layout Options m L] @

Select filter fields to include on report

. Filter By
StudentDemographicCore L (Gt A e e I T ANV X

Program £ StudentDemographicCore.SchoolName AV X

ProgramName
SchedulePriority
SchoolCode
Schoolld
SchoollRN
SchoolYear
SchoolYearld
SchoolYearType
SpecialEducation
StateStudentld
StatusCode

StatusName
Studentld AND With Next Filter ~

Equal To ~ ~

StudentNumber [J Group With Next Filter
+ Add V] Prompt For Value

SUMMARY
StudentDemographicCore.SchoolYear = " And StudentDemographicCore.SchoolName ="

¥ Cancel < Previous Next > r Save and Close

Note: If other users use this report and values must be chosen, don’t forget to select the Prompt For
Value check box.

7. Once the filter fields have been selected, click Next to move to the Layout tab.
8. On the Layout tab, the user will select the data fields that they want to view in the report. Select each field that
needs to be viewed and click +Add to move it to the right side, or you may drag and drop the fields.

% New Express Report Ad Hoc Reports

-
Name Categories Sorts Filters Layout Options B LI O

Select fields to include on report

5 Data Field Summary Function
StudentDemographicCore

£ StudentDemographicCore.LastName fx None > AV X
Year - £ StudentDemographicCore.FirstName fx None - AV X
AttendanceCode A £ StudentDemographicCore.GradeLevel fx None AV X
£ StudentDemographicCore. Homeroom fx None >~ AV X
Birthdate v icCore.i !
BirthdateVerification + StudentDemographicCore.Birthdate fx None AV X
BirthplaceCity Summarize By
BuildingProgressionTrack
CalendarBuilding [ studentDemographicCore
CalendarCode v
CalendarName
&= Add o= Add Blank ¥ Page Header []Page Footer []Grand Total
e x| F] Al ~14 2B/ u A B I FE FESE
Theme:  Custom ~
test
LastName FirstName GradeLevel Homeroom Birthdate
LastName 1 FirstName 1 Gradelevel 1 Homeroom 1 Birthdate 1
LastName 2 FirstName 2 GradeLevel 2 Homeroom 2 Birthdate 2
LastName 3 FirstName 3 GradeLevel 3 Hemeroom 3 Birthdate 3
LastName 4 FirstName 4 GradeLevel 4 Homeroom 4 Birthdate 4
X Cancel < Previous Next > || Save and Close

On the bottom portion of the screen, the user can use basic formatting features to create a clean display of the
data.
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Note: Users can use the blue up and down arrows to customize sorting further if necessary. If the
user decides they do not want to use a sorting option they moved to the right, click the red x to
delete the sorting field.

9. Once all fields have been selected and the layout is formatted, click Next to move to the Options tab.
10. Further options can be configured regarding report execution.
a. General subtab

% New Express Report Ad Hoc Reports
Name Categories Sorts Filters Layout Options B L| O
Information
Export Include Setup Info  No ~ o
Advanced
Filter Execution Window ' Default V@D Always Show Filters in Report Viewer

No Data Qualify Display Mode = Show Message ~ o

A. Include Setup Info — Provides a summary of filtering choices and places that information at the
beginning or end of the report.

B. Filter Execution Window — Default, Standard, Simple with Operator, and Simple without
Operator are available. See section 4 for further details regarding filtering.

C. No Data qualify Display Mode — This allows either a pop up message if no data is returned or will
provide a blank report.

b. Export subtab

{ﬁw Express Report Ad Hoc Reports

Name Categories Sorts Filters Layout Options B L| O

General Options

General
Default Export Type  Default ~ o

Advanced
Allow Execution in Viewer | True ~ 6

Allowed Export Types: Excel M PoF M RTF V] csv o

Report Viewer Options

Show Grid M Simulate PDF @

Excel Options

D Suppress Formatting G

Page Options

Page Size | Letter ~ Page Orientation Portrait =~ G

[ Fitto Page Width @

A. Default Export Type — Default option displays report to user on the screen. If the user prefers
to automatically export into a specific format, specify that format here so the report will run
and export.

B. Allow Execution in Viewer — Displays report on screen if set to True.

C. Allow Export Types — All options are set by default but if there is an option that is not allowed,
de-select any boxes necessary.
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D. Show grid, Simulate PDF options — Check boxes that enable an on-screen grid and/or simulate
a PDF version of the report.
E. Suppress Formatting — If exported into an Excel spreadsheet, any formatting on screen will
not be included during the export process.
F. Page Options section — Select page size, orientation, and fit to page width if desired.
c. Advanced subtab — Converts an Express Report to a Standard Report for advanced report design.

%lew Express Report Ad Hoc Reports
Name Categories Sorts Filters Layout Options B Ll O
General Convert Options
Export

Convert Express Report to a standard report (this cannot be undone) |-
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10 WORKSHOP DEMOS
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A user needs to be able to run Attendance and Year End Reports from the Analytics Hub. Knowing that the users
doesn’t need to schedule or edit reports, what security access would you provide or request for this user?

Your principal needs a Discipline Detail list for all Active students in any grade for any infraction or action. He
would like you to export the report into an Excel spreadsheet and email it to him later when you have time.
Your treasurer wants a report of Outstanding Fees sent each week from the first day of school to the last day of
school. How would you complete the scheduling of this report for the current school year for all buildings?

You have been assigned to create a report using data fields of First Name, Last Name, and Birthdate of the
student; the primary contact’s first name and last name; as well as the district admission date. Which categories
are needed to create a Standard Report for the Advance training class? What do you need to know to ensure the
future report only shows the Primary Contact?

The guidance counselors like the Unapproved Course Request Detail report but they need the homeroom
column added to the report. What do you need to do in order to achieve the report your guidance staff needs?
The guidance staff at a school district near you loves what you did to the Unapproved Course Request Detail and
would like a copy. They want to know how they can get a copy of that report for their district to use. What do
you do?

You need a quick report of student number, last name, first name, and birthdate. You want the birthdates
highlighted in blue and the first name italicized. You want to be able to filter the report by school year, school
name, grade level, and select several homerooms at a time. How would you complete this task?

ProgressBook Studentinformation Introduction to Ad-Hoc Reporting



Syncer & System Reports
11 SYNCER & SYSTEM REPORTS

***CAN BE ONLY RUN BY ITC SYSTEM ADMINS***

PBST personnel will create and maintain security roles and system reports within the Pristine database. The ITCs will use
Syncer to download the roles and reports into their production and testing databases. For Syncer to run successfully, the
database versions between Pristine and the ITC database must match.

1. Run Syncer.exe from command prompt.
(| E\SyncerClient\DASLSyncer.exe -0

2. Enter 64 and press [Enter].
3. Allow Syncer to run and commit changes to the ITC database.

(| E\SyncerClient\DASLSyncer.exe -0
Executing Synchronization for S : 64

DELETE FROM th

Committing
Commit comp

To confirm Syncer ran successfully, log into Studentinformation and go to Local > Ad Hoc Reports. Reports should now

show up as read-only.

My Reports
Pending Reports
» £ Assessment
» £ Attendance
a & Discipline
&l | Discipline Report 1
Admin
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